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Legal Notices 

Copyright Notice 

© 2018 Medis medical imaging systems bv. All rights reserved. 
 
This manual is copyrighted and is protected by worldwide copyright laws and treaty provisions. No 
part of this manual may be copied, reproduced, modified, published or distributed in any form or 
by any means, for any purpose, without prior written permission of Medis medical imaging systems 
bv. Permission is granted to freely print unmodified copies of this document as a whole, provided 
that copies are not made or distributed for profit or commercial advantage. 

Trademark Acknowledgments 

DICOM is the registered trademark of the National Electrical Manufacturers Association for its 
standards publications relating to digital communications of medical information. All other brands, 
product, and company names mentioned in this document are trademarks or registered trademarks 
of their respective owners.  
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Regulatory Information 

Intended Use 

QTavi is software intended to be used for the visualization and analysis of CT images of the heart 
and blood vessels, to support the planning and evaluation of trans-catheter aortic valve 
implantation / replacement (TAVI or TAVR) procedures.  

QTavi is intended to support the following visualization functionalities: 

- double oblique review of CT Angiographic images 

- performing caliper measurements  

QTavi is also intended to support the following analyses: 

- quantification of the anatomy both in and around the aortic root, providing aortic annulus / 
annular plane dimensions, and distances between aortic vessel landmarks 

These analyses are based on contours that are either manually drawn by the clinician or trained 
medical technician who is operating the software, or automatically detected by the software and 
subsequently presented for review and manual editing. The results obtained are displayed on top of 
the images and provided in reports.  

The analysis results obtained with QTavi are intended for use by cardiologists and radiologists to 
support clinical decisions concerning the planning and evaluation of TAVI or TAVR procedures. 

Indications for Use 

QTavi is indicated for use in clinical settings where more reproducible than manually derived 
quantified results are needed to support the visualization and analysis of CT images of the heart 
and blood vessels for use on individual patients with cardiovascular disease. 

When the quantified results provided by QTavi are used in a clinical setting on CT images of an 
individual patient, they can be used to support the clinical decision making for the diagnosis of the 
patient. In this case, the results are explicitly not to be regarded as the sole, irrefutable basis for 
clinical diagnosis, and they are only intended for use by the responsible clinicians.  

Limitations 

Currently no limitations have been specified for QTavi 1.0.18. 
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WARNINGS 

 QTavi must be used by cardiologists, radiologists, or trained technicians who are qualified to 
perform TAVI/TAVR pre or post processing analysis. If the analysis results are used to reach a 
diagnosis, the results must be interpreted by a qualified medical professional. In clinical practice 
QTavi should not be used for purposes other than those indicated in the section Intended Use. 

 Users must have sufficient proficiency in the English language, read this manual and become 
familiar with the software and be able to obtain reliable analysis results. 

 

Note on Monitor Aspect Ratio and Resolution 

 The shapes of objects and calipers displayed may be slightly distorted when the resolution is 
set to an aspect ratio different than the monitor's physical aspect ratio. This distortion does NOT 
affect the accuracy of measurements or analyses. To avoid distortion, set the resolution of the 
monitor to an aspect ratio equal to the physical aspect ratio. LCD monitors typically operate best at 
their native resolution. Microsoft Windows recommends a resolution when it has sufficient 
information to do so. 

  



 

QTavi 1.0.18 User Manual VI 

European Regulations 

 

0120 

 

QTavi is qualified as a class IIa medical device. It complies with the requirements 
of the Dutch Medical Devices Decree (Besluit Medische Hulpmiddelen, Stb. 
243/1995) and the European Medical Device Directive 93/42/EEC. 
 

 
North American Regulations 

QTavi has not yet been cleared for market in the United States by the FDA (Food and Drug 
Administration) under the provisions of Section 510(k) of the Food, Drug, and Cosmetic Act. 
Clearance is pending. 

QTavi complies with the requirements of the Canadian Medical Devices Regulations and has been 
licensed as a Class II medical device. 
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Conventions Used 

The following conventions and acronyms are used throughout this manual to indicate mouse and 
keyboard actions and to refer to elements in the user interface. 

TAVI Refers to both TAVI (Transcatheter Aortic Valve  Implementation 
and TAVR (Transcatheter Aortic Valve Replacement). 

Mouse 

Click Press and release the primary mouse button. If you are left-
handed, you may have set the right mouse button as your 
primary mouse button. 

Click and drag Press and hold the primary mouse button. Drag the mouse to 
perform a function. Release the primary mouse button. If you 
are left-handed, you may have set the right mouse button as 
your primary mouse button. 

Right-click Press and release the secondary mouse button. If you are left-
handed, you may have set the left mouse button as your 
secondary mouse button. 

Middle-click Press and release the wheel button or the middle mouse button. 
If you have a two-button mouse, press and release the left and 
the right mouse button simultaneously. 

Double-click Press and release the primary mouse button twice. 

Wheel Rotate the mouse scroll wheel. 

 

Keyboard 

SHIFT/CTRL+click Press and hold down the SHIFT/CTRL key on your keyboard while 
you click a button or object. 

CTRL+K Press and hold down the CTRL key on your keyboard while you 
press K, then release both keys. 

 

Typographical Conventions 

 
On the Annotations node of the 
Results pane… 

 
Names of buttons, fields, menus, menu options, and tab names 
are capitalized and in bold. 

Procedures > Text Annotation A sequence of menu options that you select to perform a specific 
task is indicated by angular brackets. 
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View > Movie A sequence of menu options that you select to perform a specific 
task, is indicated by angular brackets. 

 

Label: Aortic root 

 
Text that you type or that appears on the screen, such as 

annotation labels, is displayed in Courier New. 

On the Display tab, select Names of buttons, fields, menus, menu options, and tab names  
the Hide all drawings option. are capitalized and in bold. 

Symbols Used 

 Reference: Points to related documentation, or to related 
sections in this document, that may be relevant to your 
situation. 

 Tip: Provides helpful information or an alternative working 
method. 

 Note: Promotes additional information. 

 Caution: Tells you to be careful when performing a task. 

 Warning: Warns you of a potentially dangerous situation in the 
image representation or analysis, which may lead to incorrect 
results. You are advised to follow the instructions to avoid this. 
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Introduction 

1 About QTavi 

QTavi is the Medis software solution designed to support the planning or evaluation of TAVI or TAVR 
procedures. 

QTavi supports cardiologists, radiologists, or trained technicians, to select the appropriate oblique 
views of the Aortic root, before defining anatomical measurements that are required both for 
planning and/or evaluation of Aortic Root procedures. 

QTavi runs as an app in the Medis Suite product. The functionality of Medis Suite, including 
instructions on how to start QTavi and load image data, is described in the Medis Suite user manual. 
The Medis Suite documentation is available from the User documents tab, which can be opened as 
follows;  

 Click F1. 

 Pushing the  help button. 

 Select the Medis Suite main menu button in the upper right corner  > Help > User 
Documents  
 

1.1 QTavi Usage 

QTavi allows the quantification of the following anatomical entities. 

 Aortic Annulus / annular plane and dimensions (area, diameter) 

 The angle from the horizontal plane to the Annulus plane. 

 Angulation: Coronary angiography angles. 

 Distance of the Coronary Ostia (LCO and RCO) to the Annulus plane. 

 Left Ventricular Outflow Tract (LVOT) (area, distance) 

 Sinus of Valsalva (area, distances). 

 Sinus distances (LCS, RCS and NCS) 

 Sinotubular junction (area, diameter) 

 Distances (LCC, RCC and NCC) from the top of the cusps to the Annulus plane. 

 Ascending aorta (area, diameter) 
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2 System Requirements 

2.1 Hardware 

QTavi: 

 Intel or compatible quad-core processor 

 4 GB of RAM 
o If you are using larger image sets, particularly with multiple time points, please 

ensure you have adequate memory. 

 250 GB of available hard disk space 
(if you want to store images locally, make sure you have enough disk space) 

 3-button mouse, scroll-wheel recommended 

 A USB port or network connection to transfer the installer to the system 

 Widescreen monitor supporting a minimum resolution of 1920x1080 pixels 

 Video card supporting OpenGL and with 512 MB memory 

 Network interface card of at least 100MBit/s to access, receive, and send images over the 
network 

 
Sentinel license server: 

 Intel or compatible processor with a minimum speed of 550 MHz 

 128 MB of RAM 

 1 GB of available hard disk space 

 Network interface card 
 
NOTES: 

 All hardware must be compliant with the operating system 

 For the license server, a PC with a fixed IP address or a reserved IP address in the DNS 
server is strongly recommended 

2.2 Operating System 

QTavi: 64 bit version is the preferred configuration 

 Microsoft Windows 7, SP1, 32 and 64 bit version 

 Microsoft Windows 8.1, 32 and 64 bit version 

 Microsoft Windows 10, 32 and 64 bit version 

 Microsoft Windows Server 2008 R2, SP1, 64 bit version 

 Microsoft Windows Server 2012 R2, 64 bit version 

 Microsoft Windows Server 2016, 64 bit version 
 

Sentinel license server: 

 Microsoft Windows 7, 32 and 64 bit version 

 Microsoft Windows 8, 32 and 64 bit version 

 Microsoft Windows 8.1, 32 and 64 bit version 

 Microsoft Windows 10, 32 and 64 bit version 

 Microsoft Windows Server 2008, 32 and 64 bit version 

 Microsoft Windows Server 2008 R2, 64 bit version 

 Microsoft Windows Server 2012, 64 bit version 

 Microsoft Windows Server 2012 R2, 64 bit version 

 Microsoft Windows Server 2016, 64 bit version 
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3 Support 

Medis is committed to offering high-quality products and services. If you have questions about the 
software, or if you would like to make suggestions for improvements in the software or in the 
documentation, please contact the Medis helpdesk. 

If you contact the Medis helpdesk by e-mail, mention the name of the software and the version 

number in the subject field. To look up the version number of your software, select  > Help > 
About…. 

North and South America 

Medis medical imaging systems, Inc. 
E-mail: support@medis.nl  
Telephone: +1 919 278 7888 (working days 9.00-17.00 EST)  

Europe, Africa, Asia and Australia 

Medis medical imaging systems bv 
E-mail: support@medis.nl  
Telephone: +31 71 522 32 44 (working days 9.00-17.00 CET) 
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Getting Started 

4 The QTavi Workspace 

This chapter covers the following topics: 

 Overview 

 Menu bar 

 Toolbars 

 Workspace panes 

 Viewing 

4.1 Overview 

The main workspace consists of a menu bar, toolbars, several workspace panes, and the central 
window area with Double Oblique/3D/MIP/VR image viewports. 

You can customize the workspace by hiding, resizing or moving the workspace panes and toolbars. 
Any changes that you make to the workspace are saved for each individual Windows user. 
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4.2 Menu 

The menu contains commands to activate the application functionality. 

To make the menu visible: 

 Click on the menu icon  in the General toolbar. 

The menu commands are organized into the following main menus; Panes, Toolbars, Cine, Image 
Control, Procedures and Help. 

In addition there are menu items; Reset layout, Reset Window/Level, Initial View State, 
Show/Hide axes and Options. For some of these commands, tool buttons are available in the 
toolbars as shortcuts. 

 Menu commands may be grayed out when you are performing a procedure, such as a single 
vessel analysis. You can make the menu commands active by canceling or finishing the procedure. 

 

 
Menu 

 
Command 

 
Description 

 

Panes 
Show or hide a workspace 
pane 

Toolbars Show or hide a toolbar 

Cine Control the frame selection 

Image Control Control the image display 

Procedures Start a new procedure 

Help User documentation and About 

Reset layout Reset the default layout 

Reset Window/Level 
Reset the default 
window/level 

Initial view state Reset the view state 

Show/Hide axes Enable/disable crosshair axes 

Options Application default settings 
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4.3 Toolbars 

You can move toolbars to another part of the main window. You can also show or hide toolbars. 

 

 

To move a toolbar: 

 Click on the double-bar grip handle  of the toolbar and drag it. 
 
You can now move the toolbar to any location on the sides of the main window. Simply 
click and drag the toolbar to its new position. The position of the toolbar is saved when you 
close the application. 

To show or hide a toolbar: 

1. Select  > Toolbars. 

2. Select a check box to show the toolbar, clear a check box to hide the toolbar. 

Or, 

1. Right-click in the toolbar area. This opens a context menu.  

2. Select a check box to show the toolbar, clear a check box to hide the toolbar. 

The state of the toolbars is saved when you close the application. 

 

 
Icon 

 
Function 

General Toolbar 

 

Show the menu 

 

Go to the initial view state, reset zoom \ pan \ window width \ window level  

 

Crosshair Axes. Indicates the relative position of the other oblique viewports 

 

Toggle image overlay 
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Icon 

 
Function 

Cine Toolbar 

 

Go to the first frame 

 

Go to the previous frame 

 

Go to the next frame 

 

Go to the last frame 

 

Play a cine in backward direction 

 

Stop the cine 

 

Play a cine in forward direction 

 
Set the cine playback speed 

Mouse Controls Toolbar 

 

Stack 

 

Zoom 

 

Pan 

 
Window width and window level 

 
Rotate (only if the 3D viewport is selected) 
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Icon 

 
Function 

Procedures Toolbar 

 

Start an Aortic Root procedure 

 

Create a distance measurement 

 

Create an area measurement 

 

Create a text annotation 

 

Create a snapshot 

 

Copy all measurement results to the clipboard 
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4.4 Workspace Panes 

By default, the workspace displays the following panes to the right of the image viewports: 

 Results 

 Properties 

 LUTs 

 LUT Editor  

You can show or hide panes, dock panes, combine panes into one tabbed panel and remove panes 
from a panel. 

To show or hide a pane: 

 Select  > Panes, and select a hidden pane to show it, or select a visible pane to hide 
it. 

To dock a pane: 

1. Click and drag the title bar of the pane. 

2. Move the pane to the sides of the viewer window to select one of the dock areas. 
 
As the pane approaches a dock area, the area is highlighted with a dotted line. The pane 
can be combined with another pane or inserted separately. 

3. When the dock area of your choice appears highlighted, release the mouse button. 
 
This docks the pane into the selected position. 

To combine panes into one tabbed panel: 

 Click and drag the title bar of the pane to the title bar of the pane with which you want to 
combine it. 
 
This creates a tabbed panel. 

To remove panes from a panel: 

 Click and drag the title bar of the pane away from the panel.  
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4.4.1 Results pane 

The Results pane has two purposes in QTavi.  

 It shows standard procedures, i.e. measurements, annotations and snapshots performed on 
the series that is loaded in the viewport. 

 Under the Analyses folder  the Aortic Root procedure can be managed by 
selecting one of the top down guided workflow Aortic Root analysis steps. 

 

You can collapse and expand an item by clicking it. 

You can right-click a procedure to perform actions on the procedure. Depending on the type of 
procedure, you will get a context menu with several options. The options are only enabled when 
the measurement for that procedure or guided workflow results exists. 
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Locate: The image and the image orientation at which the procedure was 
originally performed will be activated. Locate is automatically done for 
QTavi analysis steps when you select a step. 

 Locate may be grayed out. This menu item is activated by cancelling 
or finishing the active procedure.  

Copy: The annotation label, distance measurement and value, area 
measurement and values, or the snapshot image is copied to the 
clipboard. 

Remove: The procedure is deleted. 

Activate analysis step:      Click on the desired analysis step, in the Results pane. 
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4.4.2 Properties Pane 

The Properties pane shows the properties of the selected procedure. You can modify the QTavi 
analysis steps or the standard procedures, i.e. measurements, annotations or snapshot procedures. 

Using the Properties pane you can edit the properties of the measurements, annotations and 
snapshots in addition to editing properties of the actively selected step of the QTavi analysis. 

4.4.2.1 Properties: Aortic Root analysis 

QTavi analysis steps are individually activated by clicking the step in the Results pane. Once 
selected, the corresponding Properties pane is shown. 

From the Properties pane of the active step, all the measurements can be created, located or 
deleted. The Properties pane shows all measurement details that pertain to that step. 

The Properties pane allows you to choose whether to display or hide the details of measurements 
that are to be shown in the Procedures (Results) pane. 

All steps of the guided workflow will be activated once the Annulus plane contour is drawn. 

To start and to modify a step in the Aortic Root analysis steps: 

1. On the Results pane, select the appropriate analysis step. 

4.4.2.2 Properties: Calipers, Annotations and Snapshots 

The Properties Pane defines both labels and details of the procedure. 

To modify a label (Measurements, Annotations and Snap-Shots): 

1. On the Results pane, select the procedure. 

2. On the Properties pane, click the ellipsis  on the right of the Label field and select a 
predefined label, or type a custom label and press Enter. 
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5 Viewing 

5.1 Loading Images 

Images can be loaded into QTavi from the Series Browser of Medis Suite. Refer to the Medis Suite 
user manual for detailed instructions. 

To load images from the Series Browser of Medis Suite 

1. Click an item in the image view or text view of the Medis Suite Series Browser to select it. 

2. Click and drag the selected item onto any viewport. 

Or, 

1. Double click an item in the image view or text view of the Medis Suite Series Browser. 

This will load the image into the viewport. A Cine will start playing to present all individual image 
frames. 

 QTavi only loads CT DICOM images. 

5.2 Viewports 

The viewport text overlay displays detailed information about the patient, the hospital, the image 
acquisition, and the display settings. 

To show or hide the patient and image information: 

 Select  > Options, Hangings. 
 

 Select or deselect Show patient information or Show image information. 

 

To maximize an image in the viewport: 

 Double-click the image. 
 
This maximizes the image, so that it takes up the entire viewport. 

To return to the original viewport layout, double-click the image again. 

 

 Interactive graphics are displayed in blue color  and allow you to change image 
or display properties with your mouse. 
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5.3 Frame selection 

You can move forward or backward through frames in the image in several ways.  

 

Moving through frames can be done by using buttons: 

 Click  or  on the Viewing toolbar to move to the previous or next frame. 

Or, 

 Click  or  on the Viewing toolbar to play a cine through the frames in backward or 

forward direction. Click  to stop the cine. 

Or, 

 Click  or  on the Viewing toolbar to move to the first or last frame. 

 

Moving through frames can be done by using keys: 

 Press the left or right arrow key to move to the previous or next frame. 

Or, 

 Press CTRL + left arrow, CTRL + right arrow to play a cine through the frames in backward 
or forward direction. Press Esc to stop the cine. 

Or, 

 Press HOME or END to move to the first or last frame. 

 

Moving through frames can be done by using interactive graphics: 

 Click the interactive graphics for frame selection (‘Frame’) on the viewports to move to the 

next frame. 

Or, 

 Right-click the interactive graphics for frame selection (‘Frame’) and enter the desired 
frame number. 

 

The cine speed can be modified with the slider  in the Viewing toolbar. 
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5.4 Mouse Controls 

5.4.1 Stacking 

You can move through the frames using Stacking when you see the stack cursor . 

 

To activate the stacking mouse control: 

 Click  in the mouse controls toolbar. 

Or, 

 Select Stacking from the viewport context menu. 

 

To stack forward or backward through frames: 

 Click and drag the mouse left and right or down and up to scroll through the frames. It will 
loop to the first or last frame. 

Or, 

 Independent of the stacking mouse control status, you can scroll the mouse wheel to stack 
through the frames. It will stop at the first or last frame. 

The current frame number is displayed on the overlay graphics in the viewport (‘Frame:’). 

 

5.4.2 Zooming 

You can zoom in and out of the viewport using Zooming when you see the magnify cursor . 

 

To activate the zooming mouse control: 

 Click  in the mouse controls toolbar. 

Or, 

 Select Zooming from the viewport context menu. 
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To zoom in and out: 

 Click and drag the mouse forward and backward to zoom in and out. 

Or, 

 Independent of the zooming mouse control status, you can click and drag on the interactive 
zoom scale graphics, or hold Ctrl and scroll the mouse wheel up and down, to zoom in and 
out. 

 

The current zoom factor is displayed on the scale graphics in the viewport. 
The value above the scale is the physical size of the scale. 
The number below the scale indicates the relative zoom: 
100% means one display pixel equals one acquisition pixel. 

 

5.4.3 Panning 

You can move the image within the viewport left, right, up and down using Panning when you see 

the hand cursor . 

 

To activate the panning mouse control: 

 Click  in the mouse controls toolbar. 

Or, 

 Select Panning from the viewport context menu. 

 

To pan the image: 

 Click and drag the mouse in any direction. 

Or, 

 Independent of the panning mouse control status, you can middle-click and drag the mouse 

in any direction to pan the image. 
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5.4.4 Window Width and Level 

You can adjust the window width and level (WWL) when you see the WWL cursor . 

To activate the window/level mouse control: 

 Click  in the mouse controls toolbar. 

Or, 

 Select Window/Level from the viewport context menu. 

 

To adjust the window width and level: 

 Click and drag 

o Right or left to increase or decrease the width. 

o Down or up to increase or decrease the level. 

Or, 

 Independent of the window/level mouse control status, right-click and drag 

o Right or left to increase or decrease the width. 

o Down or up to increase or decrease the level. 

Or, 

 Independent of the window/level mouse control status, click on the window width or level 
interactive graphics and drag up or down to increase or decrease the window width or 
level. 

Or, 

 Independent of the window/level mouse control status, right-click on the window width or 

level interactive graphics and enter the desires values. 

 The current window width and level values are displayed in the lower-right overlay graphics in 
the viewport. 

5.4.5 Initial View State 

To reset the zooming, panning and window width and level settings to the initial view state: 

 Click  to reset the zooming, panning and window width and level.
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6 Standard measurements 

QTavi supports the following standard measurements: 

 Annotations, 

 Distance measurements, 

 Area measurements, 

 Snapshots. 

6.1 Annotations 

You can add annotations to a viewport to mark it for analysis or to draw attention to specific 
details. Annotations are displayed in the viewport. All annotations of the active study are listed on 
the Results pane. 

  

When you select another series or navigate to another time point in the active series, your 
annotation is no longer displayed in the viewport. This is because the point to which the annotation 
refers does not lie on the currently visible image. To see your annotation again, right-click on the 
annotation on the Results pane and select Locate; or double-click on the annotation on the Results 
pane. 

For details on creating, editing and deleting annotations, see the Medis Suite User Manual. 

6.2 Distance Measurements 

You can measure the distance from one point to another. When you have measured a distance, you 
can modify the annotation and the end points of the measurement. All distance measurements of 
the active study are listed on the Results pane. All distance measurements of the active session are 
listed on the Results pane of Medis Suite. 
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When you select another series or navigate to another time point in the active series, your 
distance measurement may not be displayed on the viewport. This is because the points between 
which you measured do not lie on the currently visible image. To see your measurement again, 
right-click on the measurement on the Results pane and select Locate; or double-click on the 
measurement on the Results pane. 

For details on creating, editing, and deleting distance measurements and copying the results to 
clipboard, see the Medis Suite User Manual. 

6.3 Area Measurements 

You use the area measurement tool to draw and measure 2D areas. When you have measured an 
area, you can modify the area contour or annotation. All area measurements of the active study are 
listed on the Results pane. All area measurements of the active session are listed on the Results 
pane of Medis Suite. 

   

 When you select another series or navigate to another time point in the active series, your area 
measurement may not be displayed on the viewport. This is because the image on which you 
measured the area is not the same as the currently visible image. To see your measurement again, 
right-click on the measurement on the Results pane and select Locate; or double-click on the 
measurement on the Results pane. 

For details on creating, editing, and deleting area measurements and copying the results to 
clipboard, see the Medis Suite User Manual. 
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6.4 Snapshots 

You can save snapshots as evidence of an analysis or diagnosis. Snapshots are displayed on the 
Properties pane, and are listed on the Results pane. When a snapshot is created, you can modify 
the name at any time. 

 When you select another series or navigate to another time point in the active series, the 
annotations and measurements shown in the snapshot may not be displayed on the viewport. This is 
because the points at which the annotations and measurements were created do not lie on the 
currently visible image. To return to the same series and time point where a snapshot was created, 
right-click on the snapshot on the Results pane and select Locate; or double-click on the snapshot 
on the Results pane. 

6.4.1 Creating Snapshots 

You can create a snapshot of the current state of a viewport. 

To create a snapshot: 

1. Click  in the toolbar, or press the S key, or select  > Procedures > Snapshot. 

A snapshot is taken of the active viewport. 

2. On the Properties pane, click the ellipsis  on the right of the Label field and select a 
predefined label, or type a custom label and press Enter. 

6.4.2 Deleting Snapshots 

You can delete any snapshot that was created. 

To delete a snapshot: 

1. Select the snapshot in the Snapshots list on the Results pane.  

2. Press Delete on your keyboard or right-click and select Remove. 
 
This deletes the snapshot. 
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7 Performing an Aortic Root analysis 

The QTavi analysis consists of multiple steps. Each Aortic root analysis step is defined in the Results 
pane.  

The sequence begins with the Aortic Annulus step at the top of the pane and continues working 
downward. The Results pane offers a top-down guided workflow to complete an Aortic Root 
analysis. When an Aortic root analysis step is selected all the measurements and visibility of results 
of the selected step is managed from the Properties pane. 

 

 All steps of the guided workflow will be activated once the Annulus plane contour is drawn. 

The list of steps is as follows; 

 Aortic Annulus 

 Coronary Heights 

 LVOT 

 Sinus Of Valsalva 

 Sinotublular Junction 

 Ascending Aorta 

7.1.1 Define the Aortic Annulus 

To activate the Aortic Annulus step: 

1. Click on Aortic Annulus in the Results pane.  

2. Determine the position of the Annulus in the Axial viewport. 

To determine the desired view state of the plane,  

 Change the view state orientation by dragging the Axes toggles in the Sagittal or 

Coronal viewports.  

 In the Axial viewport, scroll through the images to find the correct plane. 
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To define the Annulus Plane: 

In the Properties pane,  
 
Create the Annulus contour. See chapter 7.2 on Contour Management. 

 
 Select or deselect a contour measurement to include or exclude it from the Results. 

The Annulus contour provides the following measurements: 

 Ds x Dl  : The minimal and maximal diameter of the plane. 

 Area  : The area of the plane 

 Circumference : The circumference of the plane 

 Angle  : The angle between the horizontal plane and the Annulus plane. 

 

7.1.2 Define Coronary Heights 

To activate Coronary Heights step: 

1. Click “Coronary Heights” in the Results pane.  

To define the Measurements (LCO, RCO, and AA): 

1. Determine the desired location of the LCO|RCO|AA in the Sagittal or Coronal viewport 

2. In the Properties pane, click on  to create LCO, RCO or AA. 

3. Click the position of the measurement. 

 A perpendicular line will be drawn from the clicked position to the Annulus plane. 

To locate the Measurements (LCO, RCO, and AA): 

1. In the Properties pane, click  to locate the view-state of the LCO, RCO or AA. 

 The measurement will be shown in the original orientation it was drawn. 

To delete the Measurements (LCO, RCO, and AA): 

1. In the Properties pane, click  to delete the view-state of the LCO, RCO or AA. 
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7.1.3 Define LVOT 

To activate LVOT step: 

1. Click on LVOT in the Results pane.  

2. Determine the position of the LVOT in the Axial viewport. 

To determine the desired view state of the plane,  

 Change the view state orientation by dragging the Axes toggles in the Sagittal or 
Coronal viewports.  

 In the Axial viewport, scroll through the images to find the correct plane. 

To define the LVOT Plane: 

In the Properties pane, 

Create the LVOT contour. See chapter 7.2 on Contour Management. 

 Select or deselect a contour measurement to include or exclude it from the Results. 

The LVOT contour has the following measurements: 

 Ds x Dl  : The minimal and maximal diameter of the plane. 

 Area  : The area of the plane 

 Circumference : The circumference of the plane 

 Average Ø  : The average diameter.  

 Annulus d    : The distance from the LVOT plane to the Annulus plane. 

 

7.1.4 Define Sinus Of Valsalva 

To activate Sinus Of Valsalva step: 

1. Click “Sinus Of Valsalva” in the Results pane.  

2. Determine the position of the Sinus-Of-Valsalva in the Axial viewport. 

To determine the desired view state of the plane,  

 Change the view state orientation by dragging the Axes toggles in the Sagittal or 

Coronal viewports.  

 In the Axial viewport, scroll through the images to find the correct plane. 

To define the Sinus Of Valsa Plane: 

In the Properties pane,  
 
Create the Sinus Of Valsalva contour. See chapter 7.2 on Contour Management. 

 Select or deselect a contour measurement to include or exclude it from the Results. 
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The Sinus Of Valsalva contour provides the following measurements: 

 Ds x Dl  : The minimal and maximal diameter of the plane. 

 Area  : The area of the plane 

 Circumference : The circumference of the plane 

 Average Ø  : The average diameter.  

 

To define the Measurements (LCS, RCS, and NCS): 

1. In the Properties pane, click on  to create LCS, RCS or NCS. 

2. Determine the desired location of the LCS|RCS|NCS in the Axial viewport 

3. Draw the distance of the Sinus. 

 A distance line will be drawn. 

To locate the Measurements (LCS, RCS, and NCS): 

1. In the Properties pane, click  to locate the view-state of the LCS, RCS or NCS. 

 The Cusp will be shown in the original orientation it was drawn. 

To delete the Measurements (LCS, RCS, and NCS): 

1. In the Properties pane, click  to delete the view-state of the LCS, RCS or NCS. 

 

7.1.5 Define Sinotubular Junction 

To activate STJ step: 

2. Click “STJ” in the Results pane.  

3. Determine the position of the STJ in the Axial viewport. 

To determine the desired view state of the plane,  

 Change the view state orientation by dragging the Axes toggles in the Sagittal or 
Coronal viewports.  

 In the Axial viewport, scroll through the images to find the correct plane. 

To define the STJ Plane: 

In the Properties pane,  

Create the STJ contour. See chapter 7.2 on Contour Management. 
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 Select or deselect a contour measurement to include or exclude it from the Results. 

The STJ contour has the following contour measurements: 

 Ds x Dl  : The minimal and maximal diameter of the plane. 

 Area  : The area of the plane 

 Circumference : The circumference of the plane 

 Average Ø  : The average diameter.  
 
 

To define the Measurements (LCC, RCC, and NCC): 

1. Determine the desired location of the LCC|RCC|NCC in the Sagittal or Coronal viewport 

2. In the Properties pane, click on  to create LCC, RCC or NCC. 

3. Click the position of the Cusp.  

 A perpendicular line will be drawn from the clicked position to the Annulus plane. 

To locate the Measurements (LCC, RCC, and NCC): 

1. In the Properties pane, click  to locate the view-state of the LCC, RCC or NCC. 

 The Cusp will be shown, in the original orientation it was drawn. 

To delete the Measurements (LCC, RCC, and NCC): 

1. In the Properties pane, click  to delete the view-state of the LCC, RCC or NCC. 

 

7.1.6 Define Ascending Aorta 

To activate Ascending Aorta step: 

1. Click “Ascending Aorta” in the Results pane. 

2. Determine the position of the Ascending Aorta in the Axial viewport. 

To determine the desired view state of the plane,  

 Change the view state orientation by dragging the Axes toggles in the Sagittal or 
Coronal viewports.  

 In the Axial viewport, scroll through the images to find the correct plane. 

To define the Ascending Aorta Plane: 

In the Properties pane,  
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Create the Ascending Aorta contour. See chapter 7.2 on Contour Management. 
 Select or deselect a contour measurement to include or exclude it from the Results. 

The Ascending Aorta contour has the following measurements: 

 Ds x Dl  : The minimal and maximal diameter of the plane. 

 Area  : The area of the plane 

 Circumference : The circumference of the plane 

 Average Ø  : The average diameter.  

 

7.2 Contour Management 

A contour defines a plane. The following methods are available for creating contours.  

 Auto Detect: 
o Creates both a detailed mesh representation of the Aortic Root, in addition to 

creating all contours that define all planes, e.g. Annulus plane contour.  
o Auto Detection can run prior starting QTavi, as a background process on the 

selected data. See chapter 9 on AutoQ preprocessing functionality for more details. 

 The user must check all automatically generated data and results. 

 Detect: 
o From any view orientation you can “Detect” a contour for a plane.  

  Detect replaces existing contours. 
Detect is only enabled after automatic detection has been run manually or 
via AutoQ preprocessing. 

 The user must check all automatically generated data and results. 

 Draw Contour. 

o Hand drawn contour. 

7.2.1 To Auto Detect contours 

1. Click on  in the Properties pane.  

The results of automatic detection are visible in both the 3D Viewport and the 2D viewport. 

To increase the speed of contour detection, you can pre-detect the contour 
automatically. See chapter 9 on AutoQ preprocessing functionality for more details. 

 The user must check all automatically generated data and results. 

7.2.2 To Detect a contour 

The  button is enabled after the automatically generated mesh has been created by 

running . 

1) Determine the desired view state of the plane,  
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(1) Change the view state orientation by dragging the Axes toggles in the Sagittal or 
Coronal viewports.  

(2) In the Axial viewport, scroll through the images to find the correct plane. 

2) Click on  in the Properties pane.  

The results of detection will be automatically filled in both the 3D Viewport and the 2D 
viewport. 

 The user must check all automatically generated data and results. 

7.2.3 To draw a contour 

1. Click on  in the Properties pane.  

2. On any viewport, hold the Right mouse button down and drag to draw a contour. 

 

7.2.4 To delete a contour 

1. Click on  in the Properties pane.  

7.2.5 To locate a contour 

1. Click on  in the Properties pane.  
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8 Aortic Root Analysis Options 

QTavi has Aortic Root Analysis specific options.  

To access the Aortic Root Analysis Options: 

Click on the menu icon  in the General toolbar of QTavi and select Options and 
choose Aortic Root Analysis. This will open the QTavi Options dialog. 
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8.1 Options for all Aortic Root Analysis steps 

Below is a list of options that are applicable to all QTavi Aortic root analysis steps. For example, if 
the smoothing factor of a contour is modified, then it is modified for all contours in the Aortic root 
analysis. 

 

Title Default Description 

Smooth Factor 5.0 Contours are smoothened after been drawn or 
generated.  

A perfect circular contour would have a high 
smoothing factor and a rippled contour would have 
a long factor.   

Average Diameter method Circumference 
based 

Area based average diameter. 

Circumference based average diameter. 

Min/Max based average diameter. 

Initial plane proposal On When an Aortic Root Analysis step is activated, the 
viewports will be adjusted to a proposed view-
state. The view-state is an approximation of the 
position and orientation of where that plane should 
be. 

8.2 Contour Measurement Options 

Every Aortic Root Analysis step with a contour measurement has the following options. The list 
below describes each option. 

 

Title Default Description 
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Initial plane distance  The desired distance of a plane from the annulus. This is 
used in conjunction with the initial plane proposal. 

Negative numbers implies the new plane is below the 
Annulus plane, such as the LVOT. 

Area: Dmin x Dmax On Show/Hide the average of the min/max diameter. 

Area On Show/Hide the area of the contour. 

Circumference Off Show/Hide the circumference of the contour. 

Derived average On Show/Hide the derived average. This number is 
calculated based on the Average diameter method 
selection. 

 

8.3 Aortic Root Annulus step Options 

The Aortic Root Annulus step has the following options. The list below describes each option. 

 

Title Default Description 

Area: Dmin x Dmax & Avg On Show/Hide the average of the min/max diameter. 

Area & derived average On Show/Hide the area of the contour and the derived 
average of the contour. 

Circumference & derived 
average 

On Show/Hide The circumference and the derived average of 
the contour. 

Angle On Show/Hide angle results. 
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9  AutoQ preprocessing 

AutoQ is a preprocessing functionality feature of Medis Suite which enables QTavi Automatic 
Detection to be run without any user interaction as a background process prior to starting QTavi.  

When AutoQ has run, the Auto Detection results are placed in a new series, which appears in the 
Series Browser. The newly generated AutoQ series will contain a fully segmented mesh 
representation of the Aortic root in addition to contours representing the TAVI planes. The AutoQ 
series can then be loaded into QTavi with the original data. 

 The user must check all automatically generated data and results. 

9.1 Running AutoQ 

To generate an AutoQ series do the following. 

1. Start Medis Suite and select a patient from a repository. 

2. Select one or more series in the Browser, “Series info” panel. 

3. Right click on the selected series. 

4. In the context menu, Select AutoQ > QTavi Aortic Root Segmentation 

A separate entry will appear in the series list that shows the progress and status message of 
the AutoQ process. The process will run in the background and may several minutes. 
 
A new Series will be added to the ‘Series info’ panel. 

9.2 Loading AutoQ results 

AutoQ series can be loaded into QTavi into QTavi similar to loading a standard series, but selecting 
the AutoQ series and loading it, or by dragging the AutoQ series onto QTavi. 

To use AutoQ results: 

1. Select a patient from a repository, whereby AutoQ results have been generated. 

2. In the Series info panel of the Study Browser, load both the original data and the AutoQ series. 

Then, either load the series into QTavi, or drag & drop the series in QTavi. 

To load AutoQ series into QTavi: 

1. From the Series Browser, select the original data and the AutoQ series. 

2. Right click the mouse and select QTavi 

Or: 
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1. Start QTavi 

2. From the Series Browser, select the original data and AutoQ series. 

3. Drag & Drop the original image original data and the AutoQ series on QTavi 

 The user must check all automatically generated data and results. 
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10 Reporting 

QTavi results are made available in the Medis Suite Results pane and in the Medis Suite report. 

 

The Reporting functionality of Medis Suite is described in the Medis Suite user manual. The Medis 
Suite documentation is available from the User documents tab, which can be opened as follows;  

 Click F1. 

 Pushing the  help button. 

 Select the Medis Suite main menu button in the upper right corner  > Help > User 
Documents  

11 Sessions 

The QTavi state can be saved in a Medis Suite session. The session can be reloaded to continue or 
review the analyses. 

The session functionality in Medis Suite is described in the Medis Suite user manual. The Medis Suite 
documentation is available from the User documents tab, which can be opened as follows;  

 Click F1. 

 Pushing the  help button. 

 Select the Medis Suite main menu button in the upper right corner  > Help > User 
Documents  

  



Reference 

QTavi 1.0.18 User Manual 46 

  Reference 

12 Shortcut Keys 

When you are working with QTavi, you can use several combinations of keys on your keyboard and 
mouse actions to quickly perform the following tasks. 

Press To 

Layout 

F11 Show or hide the workspace window panes 

Image control 

Middle-click and hold Hide all graphics 

Middle-click and drag, or 

Ctrl and drag 

Pan 

Ctrl+Shift and drag Zoom 

Alt+Shift and drag Stack 

Procedures 

A Create an area measurement 

D Create a distance measurement 

S, or 

CTRL+SPACE 

Create a snapshot 

Esc Stop editing the procedure 

Delete Delete the currently selected procedure 
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Press To 

SHIFT+Delete Delete all procedures 

Navigation Controls 

HOME Display the first time point 

END Display the last time point 

Arrow up Display the previous slice 

Arrow down Display the next slice 

Arrow left Display the previous time point 

Arrow right Display the next time point 

CTRL+arrow left Play cine backward 

CTRL+arrow right Play cine forward 

Esc Stop playing cine 

Page Up Display the previous series 

Page Down Display the next series 

 

13 General References 

QTavi runs as an application in Medis Suite. Please refer to the Medis Suite user documentation for 
detailed descriptions of Medis Suite functionality. 

Aortic Root anatomy references: 

RCO Right Coronary Cusps Ostium 

LCO Left Coronary Cusps Ostium 
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NCO Non Coronary Cusps Ostium 

RCS Right Coronary Sinus 

LCS Left Coronary Sinus 

NCS Non Coronary Sinus 

RCC Right Coronary Cusps Sinus 

LCC Left Coronary Cusps Sinus 

NCC Non Coronary Cusps Sinus 

14 Troubleshooting 

Missing results although Auto Detection is complete 

After a successful Auto detect, there are no contours are visible. This may occur when 
multiple time points are loaded. It is then possible that for the current time-point there are 
no contours detected, while contours have been detected for other time-points. 
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